
BASICS 

This chapter includes the following exercises: 

1.1. Thermal Wind and Temperature Advection 

1.2. Thermal Wind and the Jet Stream 

1.3. Thermal Wind and Temperature Advection in a Winter Storm 

1.4. Calculation of the Vertical Component of Relative Vorticity 

1.5. Rossby Wave Excitation by a Recurving Typhoon 

Each exercise in this manual uses these typefaces for clarity: 

Normal typeface is used for background information, technical instructions, motivating 

questions, and learning objectives. Bold indicates assigned actions and questions that 

students are expected to respond to in their report. A constant width typeface 

is used to indicate text that can be found exactly on the IDV software ( usually on the 

Dashboard or Legend areas). 

The word Optional: is used to set off suggestions for further explorations. 
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Figure 1.1. Idealized height pattern for a hypothetical Northern Hemisphere location. The dashed 

contours represent 500-hPa geopotential height, and solid lines represent 1000-hPa height. 

i. If the temperature gradient is uniform through the 1000-500-hPa layer, what is 

the sense (warm or cold) of the geostrophic temperature advection at point A at the 

1000-hPa level. How about at the 500-hPa level? 

ii. Estimate the sense of temperature advection in the middle of the layer, for 

example near the 700-hPa level. State any assumptions used in this estimation. 

iii. Use vector subtraction to draw the thermal wind vector at point A. See Eq. (1.38) 

and Fig. 1.8 in the MSM text if you need to review. What is the "rule" regarding 

the orientation between the thermal wind vector with respect to the thickness 

contours? Are the vectors you've drawn consistent with this rule? If not, resize 

your geostrophic wind vectors from a) to maintain consistency with the required 

relation. 
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1.1. Thermal Wind and Temperature Advection 

Revisit section 1.4 in Midlatitude Synoptic Meteorology (MSM) for background informa
tion corresponding to this lesson. 

Students of atmospheric dynamics know that in the Northern Hemisphere, a clockwise 
turning of the geostrophic wind with height ( a veering wind profile) is associated with 
warm advection in the layer over which the geostrophic shear is evaluated. Similarly, 
counter-clockwise turning of the geostrophic wind with height ( a backing wind profile) 

corresponds to cold advection. Can you recall why? The objectives of this short exercise 
are (i) to illustrate why and how turning of the geostrophic wind with height relates to 
temperature advection in the layer, and (ii) to evaluate the relation between the thermal 

wind and the thickness, which is proportional to the mean layer virtual temperature. 

Consider Fig. 1.1 on the following page, which shows a highly idealized set of 1000- and 
500-hPa geopotential height isopleths for a hypothetical Northern Hemisphere location. 
The dashed contours represent 500-hPa height, and solid lines represent 1000-hPa height. 

a) Examine the height contours and, based on your knowledge of the geostrophic 

wind, draw straight vector arrows at location A to indicate the 1000- and 500-hPa 

geostrophic wind. Take some care to estimate the relative magnitudes of these vectors. 
Ordinarily, the 500-hPa height gradient is greater in magnitude than that at the 1000-
hPa level, but that is not the case in this simplified example. In what sense (clockwise 

or counterclockwise) is the geostrophic wind turning with increasing height in this 

layer? What term do we apply to describe this type of vertical turning of the wind 

with height (veering or backing)? 

b) On the diagram, use "graphical subtraction" (explained below, or see section 1.4.2 in 

the MSM text) to analyze the 516-, 522-, 528-, 534-, 540-, and 546-dam 1000-500-hPa 

thickness isopleths. To do graphical subtraction, for each thickness value, find at least 
two intersection points of the given curves where the difference (thickness) has this 
value. Now connect these points with a smooth dash-dotted line or curve (a contour 

of the thickness field). Given that thickness contours essentially represent layer

average virtual temperature isotherms, indicate the location of relatively warmer and 

colder air on this diagram. 

c) Recall the mathematical expression for the temperature advection by the geostrophic 
wind, and its meaning in terms of the cross-contour component of vectors. Con
sidering the vectors you drew in a) and the thickness contours from b ), answer the 

following: 
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Figure 1.1. Idealized height pattern for a hypothetical Northern Hemisphere location. The dashed 

contours represent 500-hPa geopotential height, and solid lines represent 1000-hPa height. 

i. If the temperature gradient is uniform through the 1000-500-hPa layer, what is 

the sense (warm or cold) of the geostrophic temperature advection at point A at the 

1000-hPa level. How about at the 500-hPa level? 

ii. Estimate the sense of temperature advection in the middle of the layer, for 

example near the 700-hPa level. State any assumptions used in this estimation. 

iii. Use vector subtraction to draw the thermal wind vector at point A. See Eq. (1.38) 

and Fig. 1.8 in the MSM text if you need to review. What is the "rule" regarding 

the orientation between the thermal wind vector with respect to the thickness 

contours? Are the vectors you've drawn consistent with this rule? If not, resize 

your geostrophic wind vectors from a) to maintain consistency with the required 

relation. 
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d) Think about the relation between the height contours and the thickness (temperature). 

Then, think about the relation between the geostrophic wind and the height contours. 
Now, explain, in your own words, why a backing geostrophic wind profile in the 
Northern Hemisphere guarantees geostrophic cold advection, and conversely why a 

veering profile implies warm advection. 

Optional: 

e) On a blank sheet of paper, sketch a situation analogous to Fig. 1.1, but with the oppo

site sign of temperature advection. 

f) On a blank sheet of paper, sketch a cold advection situation in the Southern Hemi
sphere. Do the Northern Hemisphere "rules" for the relation between veering and 
backing and temperature advection hold in the Southern Hemisphere? 

g) Try to sketch a situation for the Northern Hemisphere in which a veering geostrophic 

wind does not correspond to warm advection. Is this possible? 

h) Consider the effect of friction on actual lower-tropospheric winds (not geostrophic 
winds). Do the winds veer or back through a layer with frictional effects decreasing 

with height? What are the implications for diagnosing advective tendencies from cloud 
motions you might observe outdoors, or in the lowest portion of a rawinsonde wind 
profile (see MSM section 1.4.3)? 

i) What sign of temperature advection corresponds to situations when the 1000- and 
500-hPa geostrophic wind vectors are oriented exactly opposite to one another? 

1.2. Thermal Wind and the Jet Stream 

The objective of this exercise is to apply the thermal wind concepts to provide an explana
tion for the structure and position of the westerly jet stream. Students will learn to inter
pret the jet stream's relationship to horizontal temperature gradients, in the context of the 
thermal wind relation, using gridded data. 

a) Load the IDV bundle LMT _1.2. 

To do that, just as you did in exercise 0.2, you can start from the Mapes IDV collection 
folder in IDV's toolbar, following the folder tree to select Mapes IDV 
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collection> Classes and Labs> LMT manual materials> 
Chapter 1 > LMT 1. 2 as shown here: 

Mapes IDV collection El PSD Bundles 

Case study templates ► - ◄ 
•-•l ~-•: 

Current weather ► I Structure illustrations ► I 

You should see a generally blank North American map with a north-south-oriented 
cross-section line, as shown in the screenshot in the introduction. Hold the right 
button as you move the mouse to the right, to rotate the display so that you can view 
the plane of the cross section from the west. For a direct western side view, click the 
ti' icon in the viewpoints toolbar along the left edge of the window. In the "vertical 
cross sections" area of the legend, make sure that both the "u-component" and 
"theta ... " displays are activated (checked), so that you see both the wind speed 
(shaded contours green and purple) and isentropes (contours with labels in K). Locate 
the zone of strongest westerly flow (green), which we will define as the "jet core" in 
this cross section. Describe the slope of the isentropes below the level of the jet core, 

and compare this to the slope above the jet core. Explain why the isentropic slope 

reverses as one crosses from beneath to above the jet core. Hint: Review section 1.4 

in the MSM text if needed, and see its Fig. 1.9. 

b) In the Legend window, select windspeed - I sosurf ace, which shows you the 
3D jet stream core (speed> 40 m s-1

). Jumping to a top view for a moment (by clicking 
either the ~ icon or ~ icon), it should be more apparent why this particular cross
section location and orientation was selected. What do you expect the signs of dT/dy 
to be above and below the jet? Explain why this must be the case. Hint: See Eq. ( 1.44) 
in the text. 

c) Now, check your speculation from b). In the Legend, check the boxes for 
dTdy - I sosurf ace, one for a positive value (red shading) and one for a 
negative value (blue shading). Rotate the view to see the 3D relationships. Zoom and 
pan to isolate an area where the three-layer vertical structure of blue, green, and 

red isosurfaces is clear. Capture an image (View> Capture> Image or use your 
computer's screen capture capabilities), and describe what you see there. According 
to the thermal wind relation for the geostrophic zonal wind component, what color 
of shading corresponds to regions where the westerly wind component is increasing 
with height? What color corresponds to locations where it is decreasing? Did the zones 

of positive and negative meridional temperature gradients (dTdy) match your 

expectations from a) above? 
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d) In the Legend, uncheck the box for 3D surface, which will deactivate all 
three isosurfaces in that category, and check the box to visualize all the vertical 
cross sections. Drag the section endpoints to move the cross section to another 
east-west section of the jet stream, such as south of Alaska. Recall that the thermal 
wind is directly related to the horizontal temperature gradient, and that the change in 
the zonal (east-west) geostrophic wind with height is specifically related to the north

south temperature gradient by Eq. ( 1.44) in the MSM text. Accordingly, we have dT! dy 
contour cross sections that we can now inspect to see to what extent the real data 
match the thermal wind relation. Capture a west view (east-facing image) showing 

this jet, along with the theta and dTdy cross section contours, and include this 

image in your lab write-up. 

e) Consider a meridionally oriented jet stream (with northerly or southerly flow). If you 
were given a cross section of potential temperature, could you sketch a reasonable set 
of corresponding isotachs (of the meridional wind distribution)? If you were given the 
isotachs, could you sketch a reasonable set of isentropes (potential temperature con -
tours)? On a piece of scratch paper, draw a blank east-west-oriented cross section, and 
include a large "J" to mark the jet core. Then sketch a few isentropes above, through, 
and below the jet core. Label regions where dT! dx is positive and negative. 

f) Suppose that your best friend, who happens to be majoring in underwater basket 
weaving, looks over your shoulder while you're studying the thermal wind in prepa
ration for an upcoming quiz. Being the curious sort, they ask you "What's the thermal 
wind?" Provide a written answer, in three sentences or less, that would be appropriate 
given this audience. 

g) Optional: Examine real-time (RT) weather data in same format. Load the bundle 
Mapes IDV collection> Classes and Labs> LMT manual 

materials > Chapter 1 > LMT_l. 2_RT. Orient the cross sections with 
respect to a current jet stream, selecting an east-west-oriented jet stream segment (so 
your cross sections are north-south oriented). Capture a west view showing the jet 

velocity, along with the the ta and dTdy cross section contours, and include 

this image in your lab write-up. 

1.3. Thermal Wind and Temperature Advection in a Winter Storm 

Based on section 1.4.2 of MSM and lesson 1.1 in this manual, we recognize that the turn
ing of the geostrophic wind with height is an indicator of warm or cold advection. Here, 
our objective is to apply these concepts to a winter storm event from December 2009. 
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Learning outcomes are 1) to evaluate the utility of the thermal wind concept in distin
guishing regions of warm and cold temperature advection, and 2) to anticipate how tem
perature advection regimes impact sensible weather, including clouds and precipitation. 

Following a similar procedure to that used in the previous exercise, load the bundle 
Mapes IDV collection> Classes and Labs> LMT manual 

materials > Chapter 1 > LMT_l. 3. You should see 500-hPa height and 
sea level pressure contours in black and red, respectively. The pink square designates the 
location of the skew T vs. log(p) sounding profile, which appears in its own window. 

a) Drag the pink square to a point south of Louisiana, to the west of the surface cyclone 
center, as shown in the left image below. Sketch the geostrophic wind directions at low 

and middle levels, based on the contours of sea level pressure (MSLP, red) and 500-
hPa height (HGHT, black). Now, capture a sounding image for your write-up. Does the 

turning of the wind agree with your geostrophic deductions from the plan-view 

maps? Is the wind veering or backing in this sounding? What sign of temperature 

advection is implied? Check the box to activate the colored 2-m temperature (t2m) 

display. Does the near-surface geostrophic wind implied by the SLP, acting on the 

near-surface temperature gradient, agree with the turning of wind direction in terms 

of indicating the sign of temperature advection? Explain. 

b) Next, move the sounding location into central Georgia, north and east of the cyclone 
center, as shown in the right image above. Capture a sounding image for your 

write-up. Answer the questions from a) above for this new location. 

c) Compare your two soundings from the above steps. Which of the two indicates a 

smaller dewpoint depression aloft, and thus more likely indicates thick clouds and 

precipitation near this location? Explain and justify your answer. 

d) Using the results above, postulate a "rule" about how the degree of saturation evident 

in a sounding relates to the sign of the lower-tropospheric temperature advection. 

Move the sounding around and see how generally your rule applies. We will return to 
this in chapter 2, in connection with the quasigeostrophic (QG) omega equation. 
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e) Optional: Discuss how you might use information from the movable sounding probe 
to help you locate frontal boundaries. Sketch on scratch paper how the horizontal wind 
field changes with height (pressure) ahead of and behind a cold front. Repeat for a 
warm front. Using the wind profiles from the soundings, where would we expect the 
warm and cold fronts to be located in this example? 

f) Optional: Lef s repeat the same displays for another situation, for any time from post-
1979 through February 2016. To do this, load the bundle Mapes IDV 

collection> Classes and Labs> LMT manual materials> 

Chapter 1 > LMT_l. 3_MERRA_1979-recent. Initially the same date and 
time (December 18, 2009) will come up again. If you are using IDV versions before 

5.2ul, the wind barbs will not be visible on your sounding window. In this case, follow 
the screenshot below in order to select Black on white. 

sounding_wind - Grid Sk, 

- Help 

~ ✓ Visible t-! '-12;.;.:0.c..0;.;.:0.;;...0;;....:;:;.UT-'-C::;._ _____ _ __ _ 
Lock Visibility iBIIII 

n, Show View Window r---------------
a Bring to Front ~ 

1~ Times ► 
1 . .. Display List ► 

Sounding Chart ► n Capture ► 1 -12<:rl lC>-100 

► Show ► I I X / , .~ Hodograph 
It 
~ ~ Dock in Dashboard 

Mijj.. I ::: Set Colors ... 
Delete ► :ea r 

ection White on black 

To change the geographical region examined: 

• Zoom out if needed so that the map display includes your area of interest. 
• While holding down the shift key, hold down the left mouse button as you drag or 

"rubberband,, to define a focus box on the map. 

To change the date examined: 

• Click the ~ icon in the animation control area to call up the Time Animation 

Properties menu. 

• Adjust the Start Time in the Define Animation Times tab of that 
menu to any date and time between January 1, 1979, and early 2016. 

• If you like, adjust also the End Time and Interval to include several time 
steps. Use appropriate care to limit your time range in light of available computer 
RAM and long delays in loading too much data from the NASA server. (This is why 
we recommend adjusting the display region before expanding the time span.) 
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• If you want to save your case, use the File > Save As ... dialog from the main 
display window. 

1.4. Calculation of the Vertical Component of Relative Vorticity 

Revisit section 1.5 in MSM for the text that corresponds to this lesson. 

One of the most commonly utilized variables in atmospheric dynamics is vorticity. 
Frequently, we view displays of vorticity without thinking about the calculation itself, 

and how the vorticity field is related to the wind field at that moment. In this exercise 

we will compute vorticity manually, and then compare our manual calculation to a plot 

of vorticity generated by the IDV. The learning outcomes are 1) to allow students to 

calculate the vorticity based on analyzed wind values, thereby gaining an appreciation for 

the "behind the scenes" work in generating plots of vorticity ( or similar kinematic fields: 

spatial derivatives of the winds), 2) to consider sources of error and the sensitivity of such 

calculations to dataset resolution and other factors, and 3) to evaluate the magnitude of 

vorticity in this case, and discuss its representativeness in the midlatitude atmosphere. 

Figure 1.2. NAM model analysis of sea level pressure (black contours, 4-hPa interval), and near-surface 

wind (barbs) valid at 1800 UTC 27 August 2011. Latitude and longitude lines are shown at 1 ° intervals as 

dotted lines. 
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The image below shows the near-surface wind field and sea-level pressure analysis from 

the 40-km North American Mesoscale (NAM) model valid at 1800 UTC Saturday 27 

August 2011. Latitude and longitude lines are shown at 1 ° intervals [ 1 ° of latitude = 111 

km; you can use this distance as a spatial ruler, or compute the spacing between longitude 

lines as 111 km x cos(latitude)]. 

av/ au/ 
a) Estimate , = ;ax - ;a y for a region near the storm center, using data in Fig. 1.2. 

Show your work. You will need to use "finite difference,, approximations to the deriva

tives, and estimate the u and v wind components from the barbs shown ( 1 knot = 0.51 

m s-1
). Use a distance of 1 ° of latitude (111 km) to set up a grid of points at which to 

evaluate u and v wind components, and use this distance in the denominator to com

pute spatial derivatives. State any assumptions you use in this computation. 

Value of vorticity near storm center: ______ (include mks units) 

b) Now, compare your manual calculation to the result from the IDV software for this 

same dataset. To do this, open the LMT _1.4 bundle. What range of shaded relative 

vorticity values is displayed? To find out the units and scale in the re 1 vort display, 

click on its hyperlink in the Legend to reveal its display control in the 

Dashboard. Examine the color table, as shown in this screen capture. If you like, 

change the units with the menu action Edit > Change Di splay Unit . 

Dashboard 

Data Tools 

Mapes IDV collection PSD Bundles 

~ Quicklinks Data Choosers !:j Field Selector ..... , Displays 

File Edit View Help 

Color Table: Transp ColdWarm 18 _ __ ........... Ul,...J... _ _ 101E-4s-1 

What is the maximum value on the model ~rid? To read off exact field values, hold the 

middle mouse button with the cursor in the desired location. Numerical values are 

shown at the bottom of the window ( caution: if your display window is maximized, the 

readout may be hidden). How does this compare to a typical midlatitude value of the 

Coriolis parameter or "planetary vorticity" fl 

c) Experiment with the Smoothing options in the rel vort display control until 

you think the resolution of the smoothed display matches the 1 ° scale of your calcu

lation. Now how well do the values compare? Discuss at least one reason that could 

explain the discrepancy. 
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d) Optional: How do the maximum values displayed here compare to those near the 

surface in other, more typical midlatitude situations? How do the values compare to 

those typically seen at higher altitudes, such as near the jet stream? In order to answer 
these questions, write down a scale analysis for the relative vorticity for synoptic

scale, midlatitude conditions. Based on the results above, would this scaling work for 

tropical cyclones? If not, what specific scale or scales should differ from those used in 
midlatitude synoptic weather systems? 

1.5. Rossby Wave Excitation by a Recurving Typhoon 

Revisit section 1.5.3 in MSM for the text that corresponds to this lesson. 

This lesson illustrates how Rossby waves in the upper-level midlatitude jet stream can 
transmit the impacts of a tropical cyclone (here, Typhoon Malakas of September 2010) 

eastward across the Pacific. A more general composite (averaged) study of many cases this 
phenomenon can be seen in a journal article by Torn and Hakim (2015). 

Open the LMT _ 1 . 5 IDV bundle. You will see a globe view as in Fig. 1.3 below, with 

850-hPa heights displayed in yellow (restricted to only the western Pacific), and global 

200-hPa flow depicted in several displays. Absolute vorticity is in red shading, while 

a wide red contour shows the (highly smoothed) ~abs= 10-4 s-1 isoline. The dashed red 
contour shows where planetary vorticity f = 10-4 s-1: that is, the ~40°N latitude circle. 

Wherever the solid curve is south of the dashed curve, there is generally positive or 

cyclonic ~rel' and the opposite for northward excursions of the contour. Ross by waves can 
be viewed as excursions of this contour, acting a bit like a plucked string on a musical 

instrument. 

The bundle opens at 0000 UTC 25 September 2010, when TC Malakas ( seen as a closed 

contour in the 850-hPa geopotential heights) is transitioning to midlatitudes, with its 

upper-level flow acting to "pluck the string:' Rossby waves propagate eastward from this 

event, arguably affecting weather over North America. 

a) Explore the displays. Check the boxes to display 250-hPa height (global hgt), and 

Eddy height (where eddy is defined as deviations from the zonal average around 

the whole planet along each latitude line). Step forward to 1200 UTC 25 September. 

Capture images to show how the eddy height field relates to the north-south ex

cursions of the solid red contour. Describe the relative locations of the northward

moving Tropical Cyclone Malakas and the upper-level ridge located to the north and 

east of it at this time. 
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Figure 1.3. Screen capture of LMT _ 1 .5 bundle. 

b) Step the time ahead by a few more days to identify a time with a large-amplitude 

downstream wave (trough-ridge couplet), and step forward and backward in time 

to gain a sense of the upper wave evolution. Estimate the longitude of the ridge that 

forms immediately downstream of Malakas at 1200 UTC 25 September, and track this 

feature until 0000 UTC 28 September. Use the readout of Longitude of the cursor 

at the bottom of the IDV window. Estimate the eastward speed of this ridge, utilizing 

your knowledge of the spacing of longitude lines at the latitude in question. State 

any approximations or sources of possible error in your calculation. 

c) Notice that the amplitude of the ridge weakens by the end of the time period specified 

( 0000 UTC 28 September). This indicates that energy is dispersing downstream at 

the Ross by wave group velocity, a topic di~cussed further in Chapter 2 of MSM ( see 

its Fig. 2.20 for example). As discussed in section 1.5.3 of the MSM text, a useful and 

compact graphical means of representing Rossby wave activity is the longitude-time 

section or Hovmoller diagram (Fig. 1.4 below). Utilize Fig.1.4 to locate the ridge 

associated with Malakas (which you tracked in b.) at the 500-hPa level. Compute the 

phase speed of this ridge, which is the slope of the orange streak on this diagram. 

Compare this to the value you estimated in b.) Is it consistent? Discuss the sources of 

uncertainty in these calculations. 
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Figure 1.4. Hovmoller diagram (created with http://www.esrl.noaa.gov/psd/map/time_plot/) depicting 

500-hPa geopotential height anomaly between 35 and 45°N from 17 September through 3 October 

2010. Note: An anomaly is a deviation from the time-mean long-term climatology, while an eddy field 

in the IDV bundle is a deviation from the zonal (longitude) mean at an instant. These are not equal, but 

they both expose similar patterns. 

d) Figure 1.4 indicates a series of alternating troughs and ridges that appear downstream 
of Malakas. Sketch a line approximately connecting a set of maximum amplitude fea

tures in this "wave train" of troughs and ridges. Compute the group velocity implied 

by this wave train ( or "packet") based on the slope of your line. Which is the larger 

eastward speed, the phase or group velocity? 

BASICS / 29 



72 

w 48 • w 
::, 

I ' 
::, 

0 0 
€. 24 €. 
G) G) 

E 
0 J O! 

E 
i= i= 
Cl) . ~¼ Cl) 

j •24 j 

~ 
1 I I Fi 

I I 

90E 12PE 150E 180 169W 1~W 
' I . 

-10 -7 -4 -2 -1 0 1 2 4 7 10 

Figure 1.5. Composite map sequences and time-longitude sections of meridional wind anomalies 

averaged between 35° and 55°N for extratropical transitions of tropical cyclones in the western Pacific. 

Adapted from Figs. 2 and 3 ofTorn and Hakim (2015). Note that time runs upward on the bottom panel, 

but downward in the map sequence shown and in Fig. 1.4 above. 
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e) In the IDV, rotate the globe to see remote regions (over North America) more clearly. 

How far downstream in the midlatitude jet stream do you think you can detect 

waves emitted by Malakas? Make the case using an image sequence you capture, 

annotating the features you feel are linked. Compare these results with the Hovmoller 

(time-longitude) plot in Fig. 1.4, and discuss the comparison. Examine Fig. 1.5 

(which is taken from Figs. 2 and 3 of Torn and Hakim), an average of many cases. The 

Web link to this paper is included at the end of the chapter. Relate your findings to 

that composite, which will help ensure you are not over-interpreting the data in this 

one case, since Malakas was not the only weather event or factor in the hemisphere 

causing troughs and ridges to develop over North America. In the IDV bundle, can you 

identify a source for the following Pacific "wave train" (lower part of Fig. 1.4), after the 

Malakas-triggered events? 

f) Optional: Examine other historical cases in 1979-2016 with the same displays, by 

using the LMT_l.5_MERRA_1979-recent IDV bundle, adjusting the date as explained 

in exercise 1.3 f) above, and the Web link in the caption of Fig. 1.4. 
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